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1 Introduction

The Allied Diagnostic Application Program (hereafter referred to as DGS, the mnemonic
for Diagnostic) was developed as a means to communicate with and control the ANDI
protocol based Station Site Controller (SSC), the NeXGen Forecourt Controller (NXG),
and the Aegis Forecourt Controller / 3 party software deployment platform.

DGS provides a rich suite of services for the developer, systems analyst, field technician,
et al. In addition to sending and receiving message traffic, it provides a means to load and
store command and response files, trace message traffic, download firmware, reset the
devices, et cetera.

The DGS application is written in Visual Basic (.NET) and uses the Allied Active X
Communicator object to communicate with the hardware.

Following is a screen shot of the DGS application as it appears after starting.

Allied Diagnostic

File  Trace Edit Help

Cannection Communications Commatds Status LItilities
Communications Mode Communications Parameters
) Serial
Ethernet | Serial
() Ethernet
Device Name Available Devices
10.0.1.34 v
Sign On Parameters
Device Info Part
DGSO01 0 [__Fina || FindDevices |
Services Supplied
RF&

Tool Tips are available for most controls. If one hovers the mouse pointer over a control,
after a short period of time a short description of the control will appear.

The DGS form can be minimized and maximized, but is not otherwise sizable. If you
attempt to change its size, it will spring back.

Copyright © 2015 Allied Electronics, Inc.
Page 7



Allied Diagnostic Application

2 Installation

The DGS program, along with its dependents and documentation, can be installed on a
Windows PC using one of a set of Windows MSI files, depending on your needs and
license arrangement. It will more than likely be zipped into an archive file to be sent to
you, so it will have to be extracted.

For first-time installation:

As DGS has been built on the .NET Framework, this software must be present. To this
end, a separate program: Setup.Exe has been included. This application must be run the
first time that DGS is installed if no other .NET Framework application has been
installed. Bear in mind that this Setup.Exe program takes care of the entire installation —
so no other action should be require — i.e. you should not have to run the .MSI program.

There are separate Setup.Exe programs for DGS and SDK installations.

For updating an existing .NET installation:

The DGS application is installed by one of the following classes of installation Kits:

e Allied_DGS.MSI
o The installation kit designed for deployment for installers and servicemen.
e Allied SDK.MSI
o The installation kit designed for software developers and systems
integrators.

The MSI script will perform a self installation operation with only a few user inputs.

Suffice it so say that installation is quite straight forward, as this file is included in the
installation.

Nota Bene: You cannot simply copy the DGS application to your machine. It installs a
number of dependent dynamic link libraries (DLLS).

Windows 7 and above Installation requires that the application run in Administrative
Mode.

Prudent system management practices suggest that you should make a system backup or
create a restore point before installing any software.

Feel free to contact Allied Technical Support for more information.

Copyright © 2015 Allied Electronics, Inc.
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3 File - Configuration Menu

The DGS program gets its configuration information from a Windows compatible INI
file. A default INI file (AlliedCommConfig.ini) is automatically created if it does not
exist.

Most all settings in the INI file are accomplished behind the scenes by controls in the
DGS application, so there is very little need to hand-edit the file.

The File Configuration menu item Load is used to read the INI files into which the user
saved his configuration parameters. The Save command is used to write the
configuration parameters. It is important to understand that your configuration
parameters are not written to disk until you execute the Save command or you exit the
application.

The Configuration sub-system provides a means to hand edit your configuration file.
Clicking on the Edit command starts a Microsoft Notepad session and loads the currently
selected INI file. Changes effected in the edit operation do not take affect unless one
executes a subsequent Load operation.

Note also that you can save custom configurations by using a different file name.

Following is a screen shot of a typical INI file:

I AlliedCommConfig - Notepad

File Edit Format Wew Help

;A1THed Electronics configuration file automatically created 2006.07.14
11:06:01. 245

[Communications]

Mode =Ethernet

HostId =

ceviceId =10.0.6.6

EthernetPort =6627

ZommPort =1

Speed =9600

CataBits =8

Parity =Mone

STopBits =2

MUmMRetries =3

Timeout =2000

eviceclass =DEs00

serviceClass =DESRFALOG

TraceFormat =Text "

Copyright © 2015 Allied Electronics, Inc.
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Nota Bene:

Concerning the INI file - inappropriate values are discarded during the load
operation. It is preferable to use the controls of the DGS application to set parameters as
they are most assuredly within legal range. This does not preclude hand editing; it is just
a friendly, cautionary note.

Concerning multiple DGS sessions - be mindful that unless you establish a separate
INI file for each session, the last session to touch the file will control the settings of DGS
the next time it is loaded.

In general, the DGS application is written so that it can be set up and operated in an
intuitive manner.

RFA Device selection

As the DGS application is built upon Allied’s Active-X communicator object, it contains
a fully-featured Remote File Access (RFA) server. Even though it is assumed that any
RFA traffic is destined for the device on which the DGS application is running, one
should specify explicitly the device on which the Remote File Access (RFA) sub-system
stores its files. Access to the control to set the parameter is gained through the File >
Configuration> Set RFA Device command.

Clicking on that menu item will load a modal dialog box with a directory control.
Selection is limited to currently mounted devices, and if the form is loaded with an
inappropriate value, it will default to the drive on which the DGS application is running.

More information on the RFA sub-system can be found in the ANDI Point of Sale
Interface document.

Copyright © 2015 Allied Electronics, Inc.
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4  File Command Menu

Command and palette file functions are grouped under the File-Command sub menu.
Their functionality is detailed below.

4.1 Configuration

The configuration sub-menu contains the commands associated with setting up the INI
file. It contains Load, Save, Edit, and Set RFA Device.

4.2 Command

The Command sub-menu houses all the commands associated with Command Files,
Palettes, and Palette Sets. These commands are detailed later in the document.

4.3 Response

The Response sub-menu houses all the commands associated with Automatic Response
Files. These commands are detailed later in the document.

4.4 Exit

The File->Exit command causes the application to exit. If you are still connected to a
controller, it will prompt you if you are sure you want to continue.

Warning

Yol are currently connected
shall I disconnect and proceed ko close?

If you choose to do so, it will disconnect from the controller and then proceed with an
orderly shutdown.

All daughter forms instantiated during the session will be unloaded and all resources
(files, objects, et cetera) will be returned to the operating system.

Copyright © 2015 Allied Electronics, Inc.
Page 11



Allied Diagnostic Application

45 Palette

With version 3.2 comes the ability to associate one or more ANDI protocol commands
with a user-defined button. Buttons are housed on a daughter form called a palette.

Palette files are loaded by the File> Command->Palette->Load menu command.
You may create a blank template file by clicking File>Command->Palette>New
451 Concepts

Unlike a command file, you can load as many palette forms as you like, but be aware that
there is a limit of 32 commands per form.

Following is an example of a palette form:

¥ TestCommands. pal

Si d .
Subscibe Set Config Restar 0

Restart 1 Read Time

By pressing one of the command buttons, you send vicariously one or more ANDI
protocol commands through the DGS application to the communications object.

This feature allows you to set up a series of oft-used commands without having to
navigate through the command file or retyping them each time.

Nota Bene: The command buttons are enabled and inhibited based on the connection
state.

Copyright © 2015 Allied Electronics, Inc.
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45.2 Palette File Format

The palette forms are configured through a text file roughly based on the Windows INI
file format. They have a .PAL extension.

Command specification starts with a [Command] section header followed by the ANDI
protocol command on the next line. For example: in the above palette, the Sign On
command might be specified as:

[Command]
SSC APOS0102LOGRFA

The next component is the caption used on the command button. This is similarly
specified, using the section header [Caption] followed by the caption text on the
subsequent line.

For example:

[Caption]
Sign on

The final section is the (optional) tool tip text, specified as [ToolTip]. In keeping with
the general flavor of DGS, the inclusion of meaningful tool tips is encouraged.

They are specified as:

[ToolTip]
This command establishes a session with the controller.

Note that one can specify multi-line commands, for example:
[Command]

SSC APOS0102LOGRFA

SSC CPOS0103DISDPTEML

In the preceding example, a sign on command is sent, followed by an event subscription.

Again, there is a limit of 32 commands per palette form. When loaded, the form is sized
automatically to according to the number of commands it finds in the PAL file.

Nota Bene: Palette commands appear in the Send and Message Log controls just as if
they were typed by the user.

Copyright © 2015 Allied Electronics, Inc.
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453 Palette Sets

In addition to palettes, you may save as a set the palettes currently displayed. By clicking
on the File>Command->Palette-> Set->Load command it will bring up a dialog box
prompting you to enter a .LST file.

Selecting a file will cause the current collection of palettes to be replaced by those
specified.

You can create a palette set file by selecting File>Command-> Palette-> Set-> Save.
You can remove all the palettes by selecting File=>Command->Palette-> Close All

When the DGS application exits, any palette forms are closed

Copyright © 2015 Allied Electronics, Inc.
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5 File-Response Menu

The File->Response menu manages response files. Response files provide the means for
DGS to respond automatically to certain messages that you specify.

You can select the file you intend to use with the Select File command. This command
presents the user with a dialog box from which he can select a new response file. The
Start/Stop (toggle) command starts and stops response file processing. The Edit
command brings into WordPad the currently selected response file.

5.1 Response file format:

The following tables present the key concepts of the response file format.

Control Description

Characters

; The line is a comment

* Indicates a line that contains a string that is compared with the message
from the SSC to determine if the response file contains a response for the
message.
The string may contain wildcard characters '?' that will match any
character.

- Indicates an option string for the message response.
It must follow the string preceded with an *.
Options must be separated by a space.
Arguments must not be separated by a space from the option character.
Option characters are case sensitive.

# The response for the message.
Must follow the option string or the "*' string if no options are present.

Escape Sequence Result

\\ \

\n Linefeed

\r Carriage return

\xhh Converted hexadecimal value

Copyright © 2015 Allied Electronics, Inc.
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Options Description
Cc Specifies completion code 'c'.
If not specified CC_ ACCEPTED is returned in the response.
Tnnn Truncate message at nnn.
If a response is present it is appended to the message after truncating.
N Do not respond to message.
Examples:
*TCP?? B
#TCP??ABNXG

Upon receipt of a TCP B message with any token, echo back the message, adding an A to
the completion code append NXG.

*FIM?? B
-t7

Upon receipt of the FIM B message with any token, truncate the message to 7 characters
and respond back with an accepted completion code.

Nota Bene:

e All control characters must be the first character on the line

e The token field should always contain wildcard characters

e 'C'like escape sequences may be used in the response message to enter binary
data.

e The response file is parsed for each incoming message except RFA, therefore
comments should be kept to a minimum. Comments at the beginning of the file
are skipped at construction time and do not slow the parsing process

e The token in the received message is always returned in the response

e Use response files judiciously. They are meant for testing and development and
should not be a part of any production system

Copyright © 2015 Allied Electronics, Inc.
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6 Trace Menu

The trace menu manages the built-in message tracing capability of the communicator
object. The trace facility captures all message traffic coming into and going out of the
communications resource. In the case of a serial connection, all bytes going to and
coming from the buffer of the serial port; in the case of an Ethernet connection, all bytes
coming and going to the connected socket. This does not mean that the trace facility
captures the actual data being transferred, only that which is submitted to the operating
system.

As an aside, comments entered into the Send text window are now routed into the trace
file. This allows one to annotate trace files.

Nota Bene: Cardholder data are masked automatically prior to being written into the
trace file.

6.1 Select File

One can with this command select a file into which the trace data are written. The default
trace file is specified as AlliedCommTrace.txt; which is perfectly acceptable under most
cases.

6.2 Start/Stop Toggle

One starts and stops the trace operation using this command. You can start and stop it
whenever you desire - it will not adversely affect your communications. The trace
facility writes a record into the file whenever the file is opened or closed.

6.3 View
One can view the trace file, even while tracing, in a WordPad document using this

command. When viewing, you will not receive any new data but it will be saved to the
disk. Following is an example of a trace file:

Copyright © 2015 Allied Electronics, Inc.
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I AlliedCommTrace - Notepad

Fil= Edit Formak Wiew Help

Trace file opened 2006,07.20 10:15:54, 921
10:16:00.237 % Rx thread starting

10:16:00.237 % Tx thread starting

10:16:16.18% —> SSC00 ADGSDLOZDGSRFALOG
10:16:16.199 <- S5CO00AASSCO00SFIMADDCRWDISDRT
10:16:25.739 —-» S5C00 H

10:16:25.739 - SSCO0AHOGO720101625
10:16:35.41%9 - This s obviously not a command
10:16:35.415% <- SSCOOMKPOSOOLB060720101635AE01 Msg Not Processed; CC=U; This is
10:16:43,758 % Tx thread ending

10:16:43.758 % Rx thread ending

Trace file closed 2006.07.20 10:18:35. 813

Notice that all entries, with the exception of the open and close notification are tagged
with the time. Informational messages are preceded with an asterisk (*); outgoing
messages as preceded with the right arrow = and incoming are preceded with the left
arrow symbol <

Note in the preceding figure that we were connected to a NeXGen (Ethernet). In the
following figure we are connected to an SSC (Serial). Notice that each message is
followed by an entry of the opposing direction with an <ACK>. This signifies that the
receiver acknowledged the message.

I AlliedCommTrace - Notepad
File Edit Format Yiew Help

Trace file opened 2006.07.20 10:21:15. 585 -
10:21:16.318 * px thread starting

10:21:16.318 * Tx thread starting

10:21:16. 786 <— S5CO00 ASSCO005FIMADDCRWDISDRT

10:21:16.788 —-» <ACK:>

10:21:16.786 —»> S5C00AADGS0003DGESRFALOG

10:21:16.849 <- <ACKE:>

10:21:23.2153 -» S5C00 H

10:21:23. 244 <— <ACK>

10:21:23.209]1 <- SsSCO0AH900106221418

10:21:23.291 —» <ACK>

10:21:40.278 —»> Hello world

10:21:40,310 <- <ACKE:>

10:21:40.341 <- HelloUw

10:21:40.341 —-» <ACE:>

10:21:51.011 % Tx thread ending

10:21:51.011 % Rx thread ending

Trace file closed 2006.07.20 10:21:53.647 v

6.4 Reset

The Reset command allows one to clear the trace file or restart the tracing operation.
When tracing is active, the user is pestered with a confirming dialog box before stopping,
clearing, and then re-starting.

Copyright © 2015 Allied Electronics, Inc.
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6.5 Properties

Version 3.2.1 brings a new form to control interactively the trace properties. Prior to this
release, one had to edit the INI file to effect changes to the behavior of the command
trace sub-system. With the popularity of this feature for troubleshooting, the need to
promote the controls became apparent.

Following is a screen shot of the Trace Properties form.

Trace Properties @

File Mame

CADGS_DOT_METhinhReleasehaliedCommTrace. bt Set

[rata Format Truncation
(%) Text () See all the text
) Hexadscimal (%) Limitto 1024 | characters

[] Display RFA Traffic

The File Name frame lists the currently selected file and provides a command button to
select a new file.

Data can be stored as ASCII text or in Hexadecimal format. Note that once you select
one format over the other DGS will not covert already acquired data.

So as to reduce the bandwidth and the size of potential data sets, we provide a facility to
truncate the data after a specified number of characters.

Another means to reduce the volume of data is to divert RFA messages from the trace
file. The Display RFA check box provides a means to control the data flow.

Copyright © 2015 Allied Electronics, Inc.
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7 Edit Menu

The Edit menu offers the standard Microsoft Windows edit commands for the in-focus
control. Not all controls respond to the edit commands, but the entries are included in the
spirit of completeness.

8 Help Menu
The Help About command loads the DGS About dialog.

In addition, the User’s Manual command will load the current User’s Manual into a
separate PDF reader.

9 Connection Tab

All connection related parameters, along with the Connect command button are located
on the Connection Tab. The following passages describe in detail the controls found on
this tab.

9.1 Communications Mode

The DGS program supports transparently communication using both Serial (RS-232) and
Ethernet (TCP) modes. The SSC uses Serial, the NeXGen and Aegis use Ethernet
(although they do support serial mode with a special head-shell). This mode is set using
the Communications Mode radio button or by selecting the appropriate tab in the
Communications Parameters control.

9.2 Communications Parameters

This control group supports both Ethernet and Serial controls by each one having its own
tab. Notice that the corresponding tab become active when you change the
communications mode with one of the radio buttons.

9.2.1 Ethernet Tab

The Ethernet tab contains the controls necessary to set up a TCP connection over
Ethernet. The Device Name text box can be used to manually enter the host name or
dotted decimal IP address of the controller. Alternatively, one can press the Find
Devices command button to automatically broadcast a Hailing message. This message
directs all controllers to respond to the initiator with their IP and MAC addresses. Once
all the nodes have responded, their IP addresses are placed in the Available Devices
combo box.

Copyright © 2015 Allied Electronics, Inc.
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Nota Bene: If you position and hold the mouse over the text window of the Available
Devices combo box, the tool tip text will contain the IP and MAC addresses of the
current device.

In addition, the “?”” command button creates a report of the responding devices listing
their IP and MAC addresses.

One can select an IP address from the combo box and press the < command button which
copies it into the Device Name control.

The Port control allows us to specify the local TCP port we will use for communications
with the device. Normally, one sets this value to 0 (zero) which signifies that we want
the operating system to get the first free ephemeral port it can for our operations.
Alternatively, it can be specified, but this is not recommended. Note that Allied
Electronics has reserved port 6627 from the IANA.

Nota Bene: This becomes critical if more than one instance of the communications object
is running on your PC. If more than one instance of the object is attempting to connect
using the same port number, it will be unable to create a socket.

The Ping control is used to send an ICMP echo message. If there is an entry in the
Device Name control, it will try to ping that node. Otherwise, it will simply load the Ping
form for subsequent use.

Following is a screen shot of the Ping form:

Device Mame

Status

Fing

Nota Bene: The PING command is oft times unavailable due to Windows security
restrictions. Your system administrator might have to grant you extraordinary privileges
to use this feature.
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9.2.2 Serial Tab

Similar to the Ethernet tab, the Serial tab contains the controls specific to set up your
communications link using RS-232. The Port control allows you to select any of the
available serial ports on your machine. The Baud Rate control allows you to select the
data rate from 300 through 38400 (exclusively). The default speed is 9600. The Data
Bits control specifies the number of data bits used to represent each character. This must
be set to 8 as the ANDI serial protocol uses the high order bit in its checksum calculation
as well as in RFA processing. The Parity control determines how parity is generated
and used. Normally this is set to none as we send a checksum word with the message to
ensure correctness. The last control is for Stop Bits. This sets the number of bits used to
indicate the end of a serial frame. The default value for this field is 2.

With version 3.2 comes the Default command button. This control will reset your
controls to the default parameters.

If the user attempts to connect serially with parameters other than the default, a warning
dialog box is shown with the option of cancelling the operation.

Copyright © 2015 Allied Electronics, Inc.
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9.3 Sign on Parameters

As the controller can initiate a sign-on operation, the DGS object should be able to
respond in kind. These controls allow one to specify the device information and services
supplied by the DGS application.

The Device Info text box contains the Device Class and Device Identification fields used
in the sign on and sign off process. The text is limited to 5 characters, and is normally
configured as XXXY'Y, where XXX is a device class, such as DGS and YY is a server
number, such as 01.

The Services Supplied text box contains a number of three characters service identifiers
that the DGS application will support. Typically, these are DGS for Diagnostics, RFA
for Remote File Access, and LOG for event logging. The following table lists the service
classes available at this time; see the ANDI Point of Sale Interface document for more
information.

Mnemonic Description

CBM Change Back Machine

CCH Credit Card Host

CRW Car Wash

DGS Diagnostics

DIS Dispenser Control

DPT Dispenser Payment Terminal

EML Electronic Mail

FIM Fuel Inventory Management

FPS Fuel Price Sign

IPT Island Payment Terminal

LOG Event Logging

LOY Loyalty Card Processing

RFA Remote File Access

SSC SSC System Services

PCI Payment Card Industry Data Security Standard Compliance
VND Vending Solutions — Contact Allied Tech Support for information on vending
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9.4 Connect/Disconnect Command

The Connect / Disconnect command button toggles with the state of the connection. It is
used to initiate a connection when disconnected and sever a connection when connected.
On successful establishment of a connection, the Communications tab will be highlighted
so that the user can instantly start sending and receiving messages.

Nominally, a client application (like this one) will initiate an Ethernet-based connection
to the controller. With the release of version 4.0.4, DGS can now listen for an incoming
connection request. Not all Allied controller firmware supports this feature, but for those
versions that do one can put DGS into a listening mode by clicking on the Listen
command button located on the Utilities tab. This button toggles to “Unlisten” to cancel
the request. Once a connection has been made, one severs the connection by pressing the
Disconnect button on the Connection tab.

Nota Bene: The connection timeout for Ethernet is quite long, so users are cautioned
that when attempting a connection to a non-responsive node, be prepared for
approximately a sixty second delay before receiving an indication that the connection
failed.

Copyright © 2015 Allied Electronics, Inc.
Page 24



Allied Diagnostic Application

10 Communications Tab
The Communications tab presents the main interactive controls for communications with

the device. The three frames: Send, Message Log, and Status segregate input and output.
Following is a screen shot of the communications tab:

Allied Diagnostic

File  Trace Edit Help

Conhnection Commands Status Utilities

Send

Message for ~

transmission / Click and

Drag

Command
file contents

tessage Log

Clear

10.1 Send Frame

Outbound messages can be typed into the upper text box found in the Send frame (see
message for transmission). That single message can be transmitted by pressing the Send
This button.

Messages loaded from a command file are placed in the control marked Command file
contents. Note the click and drag annotations in the preceding figure; they indicate that
one can position the cursor over the frame, hold down the left mouse button and drag the
frame over the text controls. When this happens, a new undocked Command Edit form
will appear. This provides a means to load, save, and edit the contents of the command
file. Messages loaded into the Command file contents control are sent to the device by
pressing the SendThese command button.

Nota Bene: You can also send commands one at a time from the command file by double
clicking on them.
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10.2 Command Edit Form

The Command Edit form, depicted below, can be loaded by a drag operation in the Send
frame or through executing the Command = Edit menu sequence.

# Command Edit
File Update

This form allows the user to load and save commands files off disk. It also provides an
Update command to transfer the contents of the window into the send frame’s command
file contents control. It should be noted that one cannot directly edit the command file
contents in the send frame other than to erase it with the Clear command.

10.3 Message Format

The format of the messages, whether they are entered interactively, or loaded through the
command files, follows the General Application Message Format (82.9) published in the
ANDI Point of Sale Interface document. It is assumed that the reader will have this
document. In the event that you haven’t a copy, contact Allied Electronics for
information on how to obtain one.

Messages starting with a forward slash or semi-colon are treated as comments. They are
routed to the Trace file if enabled, and otherwise ignored. They are not sent to the
device.

Hexadecimal values can be entered by a preceding \x or \X. The very next two characters
must be legal hex values 0123456789abcdef or 0123456789ABCDEF.

With the exception of an empty string, the DGS application will attempt to send whatever
is entered into the text control.
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10.4 Message Log

The Message Log shows the messages sent (in red) and received (in blue). The top
portion shows all the messages received since the last time the Clear button was pressed.
Due to the fact that we fixed the size of the form, you might not be able to see all the text
of longer messages. To remedy this, the text box immediately below shows the currently
highlighted message. One can then scroll through the message at will.

Like the Send frame, this frame also can be dragged to create an undocked Message Log
Form.

Nota Bene: Cardholder data are masked by DGS before being placed in the message log
control.

10.5 Message Log Form

If you click and drag the Message Log frame, you will cause the Message Log form to be
loaded. This form is resizable, so you can stretch it out to encompass an entire message.
It is kept in synchrony with the Message Log form. This form also allows the user to
save and send message contents.

File

Nota Bene: Cardholder data are masked by DGS before being placed in the undocked
message log form.

Pulling down the File menu entry uncovers Save, Print, and Exit commands.
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10.6 Status

The Status text window displays the status, when appropriate, returned from the
communicator object. This is a read-only display.

Allied Diagnostic

File  Trace Edit Help

Connection Communications Commands Utilities
Paort Status

Puort Function State Status 2

POS Disconnected | CTS & DSR Mot Active

2 FOs Digconnected CTS & D3R Not Active

3 hBL Digconnected CTS & D3R Not Active

4 TLS Waiting Link Idle (Awaiting Config)

5 DIs Active Tirneout (Mo ACK/MNAK) Errar

6 nIs “Waiting Link Idle (Awaiting Config)

7 [ Mot Used FortMotln Use w

Swstem Information

Y'ou are connected to the Allied Electronics NeXGen Systern on the 84500 platiarm
[tis running program MDMNBO0ON Res 10

Get Status

Response Received 03-Apr-14 16:46:25

The Status tab will update automatically whenever the controller detects a change in state
as long as the tab is active. In addition, the Get Status command will force the controller
to refresh the table. When connected to the SSC, 16 ports are reported. When connected
to most versions of the NeXGen/Aegis 32 ports are reported, although certain versions of
these newer controllers will report up to 64 ports.

More information on the State and Status entries can be found in the ANDI Point of Sale
Interface document.
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11 Commands Tab
The Commands tab provides access to built-in, high-level command functionality.

It is arranged by functionality, including Security, Command Tools, Purpose-built
Configuration Forms, DPT/IPT Printer Test, and Dispenser State.

Following is an image of the Command Tabs screen.

Allied Diagnostic =3

File  Trace Edt Help

Connection Cammunications Status Ltilitie:

Configuration Forms

Cormmand Tools
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111 Security

The Payment Application Data Security Standard mandates, among other items,
password protected accounts. In order to aid in the management of this sub-system, DGS
has a log on form and System Security Management form.

While the ANDI protocol has a Sign on message, it must not be confused with the
PA/DSS mandated Log on message. Sign on, establishes a behavioral relationship with
the controller; log on establishes a level of security.

The Log on command provides a means to log on (securely) at any time. DGS
automatically presents to the user this form when receiving a sign-on indication or
response from the controller. This command is simply provided as a direct means to
access this form should the need arise.

User Mame Fazsword

Mew Password Confirn Mew Passward

0] |

[] Enciypt Passwords
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The Accounts command causes the System Security Management form to load.

System Security

File  User
Izer Mame
|
Pazsword Confirm Password
Mew Pazzwaord Confirmn Mew Pazzwaord

[] Encrypt Passwaords

As depicted above, the System Security Management form provides the controls to
add/change/delete/reset user’s accounts and passwords.

The functionality provided by this form is recognized only by those firmware versions
that are PA/DSS compliant. While the commands may be sent to non-compliant
controllers, they will have no effect other than to elicit an error response.

The User name, Password, and New Password text boxes are used as input to the User ...
commands. Fill-in the data and then press the appropriate menu command.

With the migration from PCI/DSS to PA/DSS, we must now encrypt strongly the
passwords as they are communicated from the DGS application to the controller. By
checking the Encrypt Passwords box, one enables this feature.

There are two files associated with PA/DSS compliance: User Accounts and Audit Trail.
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1111

11.1.2

11.1.3

1114

11.1.5

11.1.6

11.1.7

11.1.8

File Read Audit Trail

Pressing the File > Read > Audit Trail command prompts the user for a file
name and then directs the controller to upload to DGS the audit trail data to that
file. After the last of the data are received, the file is loaded into word pad and
displayed.

File Read Users

Pressing the File > Read - Users command directs the controller to upload a list
of the users, their class (administrative or normal), and the hashed password. The
data are displayed in word pad similar to the Audit Trail but under a fixed file
name.

File Exit

File > Exit unloads the System Security Management form.

User Add Normal User

Pressing the User->Add - Normal User command sends a message to create a
normal (non administrative) user’s account on the controller using the data from
the text boxes.

User Add Administrator

Pressing the User->Add = Administrator command sends a message to create an
administrative user’s account on the controller using the data from the text boxes.

User Change Password

Pressing the User - Change Password command sends a message to change the
specified user’s password using the data from the text boxes.

User Delete

Pressing the User = Delete command sends a message to remove the user
specified by the User Name text box.

User Reset

Pressing the User - Reset command sends the command to reset a locked out
user. This condition exists if the user log-on fails after 6 attempts.
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11.2 Command Tools

The Command Tools controls provide an alternate route to load a command file or a
command palette. These controls perform identically to their counterparts found on the
main form’s menu bar.

11.3 Configuration Forms

With DGS version 3.2 comes a series of forms that provide controls to specify the
parameters of the key configuration commands. While the ANDI message set is well
thought out and “mature” it does contain somewhat long messages. The forms in this
section provide a graphical means to gather and present these data. They allow one to
read from the controller and write to either the controller or to the clipboard, and are
normally populated with data when first displayed.
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11.3.1 Station

The Station-Wide Configuration form assembles and decodes the DIS O or (0) message.
Following is a screen shot of the form.

£ Station-Wide Dispenser Configuration

File  Configuration
Dispenser Brand Sales Display Delay Frice Sign Optional Parameters
[Gilbarco v J 03 Mode of Service Maximum Customer Recards | 2
Cal OFul @ sef O Mini T —
Dispenser Loops tanitar Interal Price Level J oon
Channel1 |4 » J 1 O oal O Cash @ Credit
Channel 2 1} £
Product 1 Product 4 Yolume Limit 0000000
Channel 3 1] v Price Change On Handie Up 0 o 0 Product 7 | O
Channeld |0« Erase After Pageoif Froduct2 | g Products | Product & | 0 [ Use MTEP Rules
Product 3 Product 6 Product 3
Pure Praduct D etail 0 rosu o rosu 0 Post-Pay Timer
Fast Pay Limits Operafion Made Price Change Sign Time-out J 000
Cash 99999 J 030
DIS Subseriber Required w
Credit 99999
Miniraurn Discount Price ooio
Long N Fi t it Do
[ Loz e Dehit Price Level PFrice Change Dispenser Time-out
Slowd et @ Cash O Credit J
owdown Offse 030
J 15 Attendant Price Level
&) Cash O Credit Price Change Contioller Latency
Sales Display Mode Frepaid Card Price Lewvel J 30
Mo Affect 4 ® Cash O Credit

As with all forms in DGS tool tip text provides basic guidance. For details on the DIS O
message, please refer to the POS Interface for ANDI Systems and/or the POS to ANDI
Configuration Options documents.

Copyright © 2015 Allied Electronics, Inc.
Page 34



Allied Diagnostic Application

11.3.2 Dispensers

The Dispenser Configuration form provides a graphical representation of the DIS M
command. The DIS M command, as opposed to the DIS O command provides fueling
point specific configuration. During the loading process a read DIS N command
(specified as read all) is sent to the controller, which returns a configuration record for
any and all fueling points that have been configured. When an un-configured fueling
point is specified in the “Dispenser” control, the form will copy the data from the first
one it finds, applying it as a starting point. One can un-configure a dispenser by pressing
the Delete All command button and then sending the configuration.

Following is a depiction of the form.

Dispenser Configuration

File  Configuration
Dispenser Frice Level Selection Optional Parameters
1 v Model: | O (#) allow Price Level Default [] DPT Has Barcode Scanner
) Select Price Level Slowdown Offzat
Products () Confirm Price Level J ooo
Hosel |1 Hose5 | 8
Hose? | 2| HoseE | 9 Authorization Mode
(%) Standard Mode DFT Supports Credit
Hozed | 3 Hoze? | 0
e e ) &t Authorize [ DPT Supports Debit
Hosed | 4 Hozed | D
O Fre-Pay Only DPT Il Prompt
Delete All DPT Idle Prampt 2 w
Autamatic Fay Of
: . DPT Prezet Mad
Device Type Fields O Ne O ves @ al fesEl Mode
Usze walue from DPT J cmd v
Blender 0
Keyboard E YesiMNo Options Sales Display Mode
[] Sale Stacking Az et by station config w
Mode Of Service Single Hoze MPD
O Rl @& Self O Mini [] Start Button Used Sales Display Delay
DFT Haz Card Reader
: = ) |999
Frice Level Default [] DPT Has Cash Acceptor
(®) Cash (3 Credit [ DPT Iz Encrypted
Received record(s) For FP 01 02
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11.3.3 Dispenser Payment Terminal (DPT)

The DPT Configuration form provides a graphical representation of the DPT J command.

The form operates similarly to the aforementioned in that it reads the existing
configuration on initial display and provides the means to write the configuration to the
controller or the clipboard.

Following is a depiction of the form:

PTConfiguration

Configuration

Operation Mode

|POS Canfirmation j Rl
Aftendant Mode
| Disabled v

Custarner Prompt Mode

fNo transactions wait for DPT m v

Barcode Mode
iﬁulsn:le [via DPT d] v.

Report Calling As ldle

E.\N;'i.l\.ca.ll. on Handle up v

Card Suspends Post Pay
[ Remove Mozzle Pay Inside
Card Hast Stare and Forward
Pay Inside Prompt

[ “oucher Enabled

] Hot Authorize Credit

] Hat &utharize Debit

Press Enter When Done
] Show Debit &3 ATHM/Debit
[] Transaction Fes Prompts
] Receipt Prompt Default
Language Selection

Advertisements

() Dot Show ) Show logo

Preset Mode

|Mever Prampt
Encryption Mode
EMasler Session
Change Code Mode
[y at CEM

Card Reader Pay Mode

|Auto pay after nozzle replaced

Report ldle As Calling

E.\N;'i.ll. nat call on bution pus‘h

Transaction Seed [ ooom |
Attendant Card Prefix | HER |
Company Code

DFT Loops
Chanl [ ]
Chan2 [0 ]
Chand [0 ]

Chand [0

Default Language

[English v|

(%) Show Ads

Receipt
Prompt Mode

Before, while, or after fueling | s

M ax Receipt Count 2 ._
Min Receipt Lines 20 |
PFrint Customer Account Humber
[] Full Service Receipt

[] POS Farmats Receipt

[ POS Receipt Oriy

Seconds Await Bill First

J 030 |

Card Type Selection

[P05 sats Creditor Debit v
Credit Support

(&) Yes ) Mo

O DPT Only ) IPT Only
Dehit Support

@) Yes ) Mo

O DFT Only ) IPT Only
Change Code Enabled

&) Mat Used O 8LDPT

(O ALDPT and CEM

Carwash
Frompitdode E
|Newer - Mot Used v

Frint Mode

) Yes &) Mo () Reverse

Minimum Gallons

y, 00

Carwash Discount | 00000 |

Show Price

@ Mo O with Tax (O Withaut Tax

Fequires Printer

Cash Handling
Account Limit | 0ooon

Bill Limit 0o |
Cash Acceptor Pay Mode
Auto Pay &l &

Requires Printer
Femaining Ealance Disables Cash

Member Mode
[ Key enty allowed as member D
[] Card allowed as member I
[ Barcode allowed a3 member D

Barcode az payment or discount coupon
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11.3.4 KeyPad

The SSC and NeXGen controllers have the ability to map physical keys to logical keys so
as to assign specific functionality. The DPT N command can be used to accomplish this,
but requires certain knowledge of the hardware that is not always available to the casual
user. To make this task easier, a Keypad Configuration feature allows one to build the
command using a graphical form.

The layout of the keypad and key assignments are stored in .KBD files

When the KeyPad command button is pressed, it loads a blank constructor form — as
follows:

L KeyPad Constructor, E|E|@
| Fil=  Configuration

One can then load a template file by clicking on File & Load

Here is an example of a test keyboard containing two banks of soft keys, a main keypad,
and an auxiliary keypad.

L KeyPad Constructor: Type1.kbd

File  Configuration
Keypad Type M anufacturer
h Diefault v
' N N 7 N 7 N £ N
Qutside
1 2 3 XXX .
Credit
A 7N AN /N N J/
' N N 7 N 7 N £ N
Inside Inside
4 8 6 Cash Credit
A J J N AN VAN J
'd N 7 N 7 N 7 N 7 N
7 8 9 No Yes
A J J N AN VAN J
'd N 7 N /7 N 7 N 7 N
Clear 0 Enter Help Cancel
\ N J N AN AN VAN J
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In addition to the Keypad Constructor form, a Key Properties form is also loaded.
Following is an illustration of this form:

™ Physical Key - 32 (0x20) X]

Phyzical Characternstics
Keypad = Primary
Physical Key = 32

Logizal Key
Murmeric 1 w

As one clicks on the various keys on the constructor form, the Key Properties form is
updated with the information associated with the selected key. The Logical Key control
provides the means to set the logical key value associated with the selected key.

If you click on a key for which there are two positions (tall or wide key) or there are two
logical keys, the Key Properties form will grow to include information on the special key.

This is illustrated in the next section.
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11.3.4.1 KBD File

The heart of this subsystem starts with the KBD file. This file (in modified INI format)
provides not only the means to specify the layout of the keys on the form, but the
keyboard type, shape, physical, and logical values.

A template might include just the rows, columns, shapes, and physical values for the
keys. The user might then specify the type and the logical values.

The type field is a single alphanumeric value used by the controller to select a keypad.

Legal values are:
{0123456789ABCDEFGHIJKLMNOPQRSTUVWXY Zabcdefghijklmnopgrstuvwxyz}

It is specified in the file after the section heading [TYPE]
For example, to specify a keypad of type J, one would expect to see in the file:

[TYPE]
J

There are five distinct groups of keys that can be specified: Left Soft Keys, Right Soft
Keys, Primary Keys, Hot Row Keys, and Auxiliary Keys.

In above example all the keypads are used so as to illustrate how they are rendered.

The keys groups are differentiated by section headers as:

[SKL] (Softkeys — Left)

[SKR] (Softkeys — Right)

[AUX] (Auxiliary keypad)

[HOTROW] (Hot row — rendered with the primary keys)
[KEY] (Primary keypad)

Each key to be defined starts with one of the five section headers.
The attributes for each key are specified in a single line and in comma separated entries.

For each key there are a total of five attributes: row, column, shape, physical value, and
logical value.
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For a “template file” one has to specify the row, column, shape, and physical value of all
the keys. The user can then fill in the logical value for each key and from there save it on
disk as well as create the DPT N command.

The row attribute (range 1 through n) is specified by the letter R. The column attribute
(range 1 through n) is specified by the letter C.

For example: one might want a key on the primary keyboard at row 2 column 3. It would
be specified as:

Nota Bene: The Row and Column specified here are not necessarily the same as those on
the actual keypad. They are used to arrange the keys in the display of the form. By and
large they will be, but one can draw the keypad as one sees fit.

The shape of the key is the next item in the attribute list. There are four distinct shapes
supported: Hidden (0), single row single column (1), single row two columns (2), and
single column two rows (3). The shape is specified using the letter S.

Building on our previous example, if our key is a simple rectangle, our entry becomes:

[KEY]
R=2, C=3, S=1

Hidden keys are available so that one can map two physical keys to the same logical
value. Note the Rewards VVoucher key has a type 2 shape. By clicking on the key one
can alternate between specifying the row 5 — column 1 and row 5 — column 2 keys.

The two forms below illustrate:

Phyzical Characteristics Phyzical Characteristics
Keypad = Primany Keypad = Primany
Fhysical Key = 0C Fhysical Key = 0D
Geometry = Wide Key Geometry = Hidden Key

Logical Key
Gaz B Vi

Update Update
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The physical value is that which is actually returned from the hardware. It is a number
between 0 and 255 and can be specified as numeric or hexadecimal.
Note that hex values are specified in the conventional manner (0x00 through OXFF).

Adding again to our example, let us assume that the value returned to the controller from
this particular key is 38 (base 10), our entry becomes:

[KEY]
R=2, C=3, S=1, P=38

The last attribute is the logical value which is used by the controller. This controls the
behavior of the DPT state machine. Its range is specified in the ANDI Point of Sale
Interface document in the DPT data element dictionary section.

In a “template file” this entry can be left blank and it will be assumed that the key is
unused. The user will then fill-in the entry using the Logical Key pull down and Update
commands on the Key Properties form.

11.3.4.2 Keypad Constructor Commands

KBD files are loaded with the File=> Load command. Like most other file load
operations in DGS, a dialog box is popped up wherein one can specify the file. The last
location where a file was loaded is remembered for convenience.

One can hand edit a KBD file with the File=>Edit command. If a file is in-use, this
command will load the Notepad application and cause it to read in the current file.
Changes made in the file will not be reflected in the interactive form until the file is
reloaded.

Changes made through the KeyPad Constructor form are saved to disk by the
File> Save command.

Clicking File->Exit causes the KeyPad Constructor and Key Properties forms to be
unloaded.

With the introduction of the X-Files class of controller firmware (which includes support
for all peripheral types in single builds) a manufacturer tag must be appended to the
keypad construction message. These data are specified through the Manufacturer
control.

The Configuration=>Write... commands build a DPT N command from the current data
and either send it to the controller or write it into the clipboard.
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The Keypad Type can be specified by entering the single alphanumeric character in the
text box and then pressing the Update button. No changes take effect until after you
press the button.

As you navigate about the keys on the form, their attributes are communicated to the Key
Properties form.

Where keys span more than one physical location or have more then one logical value,
there is typically a “hidden key” which is used to specify/store the other value.

By repeatedly clicking on a key the “primary” and “hidden” keys are alternately selected.
11.3.4.3 Key Properties Form

This form provides the means to set the logical value for a key. The current value is
written into the Logical Key control when the key is selected on the Keypad Constructor
form.

The logical key value can be set by selecting the new value in the combo box control and
then pressing the update button. No changes are made until such time as the button is

pressed.

When a KBD file is loaded this form pops up automatically right in the middle of the
Keypad Constructor form.

If the form is closed, it will reappear as soon as a new key is brought into focus.
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11.3.5 Product Pricing

Fuel prices can be read and written through the Prices command button. Pressing the
button will load the Product Pricing form.

This form, like the keypad form, can be used online and offline.

Following is an illustration of the form:

Product Pricing E|E|

File  Configuration  Price Formak

Product Cazh Full Cazh Self Credit Full Credit Self
Fuell o~ 0000 ; 1111 1 ‘o000 1 1111

Editing Fuel 1

This form implements that DIS Q/q and DIS R/r commands. One navigates through the
prices by clicking the arrow keys, or selecting a product.

Nota Bene: The form does not support mini service due to its severe decline in our
industry. The ANDI message set still supports mini service; users requiring mini service
can construct the DIS Q/q R/r messages by hand, create a series of palette commands, or
a series of commands files as necessary.

Commands

The File menu contains just one command File = Exit. Clicking on this unloads the
form.

Clicking on the Configuration - Read command will construct and send a DIS R or

DIS r command (depending on the state of the Price Format control. On receipt of the

price information, DGS will create a collection of prices and populate the controls with
the first product specified.

One can then navigate through them, as mentioned above. To change a price, you can
type the new price in the appropriate text box. When you are satisfied with your entries,
press the Update command. This will update the stored price in DGS.
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To convey the information to the controller (or to the clipboard) click on either
Configuration > Write - To Controller or
Configuration - Write - To Clipboard (respectively)

In addition to the ability to write the prices, you can see your configured prices in tabular
form by pressing Configuration > Create Report

This will generate and load a temporary file entitled Prices.tmp and looks like the
following:

[} Prices.tmp - Notepad E@E|

File Edit Format Wiew Help

Product Cash Full Cash 3elf Credit Full Credit Self
Fuel 01 01111 01111 0111z 0zzzz
Fuel 02 01211 0izz1 0121z 0i1zzz
Fusl 03 01311 01321 0131z 013zz2
Fuesl 04 oi1411 o14z1 o141z o142z
Fuel 05 oi1511 o15z1 o151z o15zz
Fuel 06 Ooile1l O1la6z1 0l6lz 0162z
Fusl 07 o1711 o17z1l o1viz o17zz
Fuel 05 01511 01521 0181z 015zz2
Fusl 09 01911 01921 0191z 01922

Note that if you set one of your products to Not Used (the first entry in the Product drop-
down box) you will be asked if you want to delete the product.

Further, if you make a change to one of the prices and then navigate off the product, you
will be asked if you want to keep your changes.

While there is only one product listed at a time, you can access the others by clicking on
the left arrow, right arrow, or selecting another product in the Product combo box.

Selecting a product that exists allows you to edit the current contents. Selecting one that
does not yet exist generates a new product and sets the prices to zero. You can then type
in the appropriate values.

Pressing the Clear button sets all the prices to zero, but maintains the product in the
collection. Again, to remove a product, you would set the Product to Not Used.

The status bar at the bottom of the form provides some feedback, listing the result of your
most recent action.
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11.3.6 Blend Ratio

The blend ratio commands (DIS U and V) can be managed interactively through the
Blend Ratio form, pictured below:

Blend Ratios

File  Configuration  MsgFarmat

Pure Pure

Product
Product ;
1 (Low) 2 (High)

Blended
Product

Mone -

Blend Ratio
* | 50

<

Mo blend ratio records returned from the controller

General Operation

The form starts by reading any existing blend ratio records from the firmware and
bringing them into a local database for editing. If no records are available, if you press
the right arrow or enter a product, a new record will be created. If you want to add a new
record an existing set, just press the right arrow to the end of the records and it will create
a new one (after asking you if it is ok). Changing the blend ratio is just then as simple as
moving the slider from side to side or entering an exact value in the text box. Pressing
the left arrow or right arrow will move you from record to record within the database.

Commands
Selecting the File = Exit command will cause the form to exit.
The Configuration 2 Read command will send a read blend ratio command to the

controller (if connected). When we receive the response message the current data will be
erased and a new database built.
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The Configuration = Write provides two commands: To Controller and To
Clipboard which are used to send the blend ratio to a connected controller or to the
clipboard so that you can paste it into a command file or command palette.

The Configuration = Create Report command is used to build a report of the contents
of the blend ratio database. An example follows:

P Blends.tmp - Notepad
File Edit Format Wiew Help

burrently configured blend ratio records:
Fuel Product Z iz comprised of Z6% Fuel Product 1 and 74% Fuel Product 3
Fuel Product 6 iz comprised of 6%9% Fuel Product 4 and 31% Fusl Product 5

The MsgFormat commands specify the number of acceptable products (1 through 9 in
short format) or (1 though 78 in long format)

Nota Bene: If you switch between long and short you will be asked if you want DGS to
remove the out of range products automatically.

The three combo boxes underneath the graphical tanks are used to specify the products
used in the components of the blend ratio. They are populated with the legal selections
based on the selection of the MsgFormat control.

The Clear button is used to set the current blend ratio into a state where it will be
removed when the controller receives it. You can do the same thing interactively by
setting the blended product to pure product 1, setting pure product 2 to None, and setting
the blend ratio to 100 percent

The Delete button is used to remove the current record.
The Blend Ratio slider and text box work together to specify the ratio of product 1 to

product 2 in the blended product. Note that the ratio is graphed in the Blended Product
tank by the changing color boundaries — red for product 1 and blue for product 2.

Copyright © 2015 Allied Electronics, Inc.
Page 46



Allied Diagnostic Application

11.3.7 FpCfg File Management

With the ever increasing use of Extensible Markup Language (XML) files for configuring
the forecourt controller, the need has arisen for an interactive form to assist in the
construction of the XML file used for fueling points.

To this end, the FpCfg File Builder form has been added to DGS.

Following is an image of the file at load time:

FpCfg File Builder

File  Fueling Point  Help

) i Controller
Fueling Paint

Select Mow

Fayrent Terminal
Dpt Address Controller Port

| a3 | | ]

Dpt Channel Type

| v
IP Address
L IC ]
Dispenser
Dis Address Controller Piort
| vl v
Diz Channel Type Side
| o | ]
toneytd ode Yolurne Timer
[
Debug Info Log Style

[ =& ([
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This form can be used without regard to the state of your connection to the controller, as
it uses a local copy of the XML file. This means that in order to deploy the changes, one
must download the file to the controller. This can be accomplished by the CF Access
form or by using FTP or RFA commands.

Nota Bene: FTP is no longer supported for PA-DSS 2.0 compliant firmware.
There are 3 groups of menu bar commands: File, Fueling Point, and Help

In the File group one can Load a new file, set the Format of the output file (see the NXG
FpCFg XML documentation for more detail), Save a file to disk, and Exit the form.

In the Fueling Point group one can Add a new fueling point, Delete one, and Create a
Report of the fueling points by Fueling Point Number or by Channel.

The Help group is also the command, which causes the current NXG FpCfg XML.PDF
document to be loaded into a separate PDF reader.

The form is divided into roughly equal panels — the left side containing the controls to
configure the fueling points and the right containing a “tree view” control to select a
particular fueling point or to select the controller itself to add a new fueling point.

The controls are context sensitive — in other words — they are turned on or off depending
on whether you are adding, deleting, or editing a fueling point.

11.3.7.1 Add a Fueling Point

In order to add a fueling point, you must select the Controller element in the right pane.
Doing so will cause the Fueling Point control to read “Select Now.” You can then use
the Fueling Point combination box to select any legal fueling point not already in use. In
addition, DGS will read as much data as it can from the last fueling point and write it into
the nascent fueling point.

Provided you don’t navigate off the controller, you can then use the remaining controls in
the left pane to configure this new point. When you are satisfied with your settings, you
must then click the Fueling Point - Add menu command to add it into the right panel.

It should then appear as a new entry under the controller (in numerical order).
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11.3.7.2 Delete a Fueling Point

Deleting a fueling point is carried out by selecting the condemned fueling point in the
right pane and then selecting the Fueling Point > Delete menu command.

11.3.7.3 Reports

To generate a report of your fueling points by fueling point number, simply click on the
Fueling Point - Create Report - By Fueling Point menu command.

To generate a report sorted by controller channel, simply click on the Fueling Point >
Create Report - By Channel menu command.
11.3.7.4 Xml File Format

At the present time, there are 2 flavors of XML file — format 1 and format 2. Format 1 is
the “legacy” version and supports only configuration of Payment Terminals. Format 2,
on the other hand, supports both payment terminal and dispenser configuration.

Not all systems support format 2, and users are advised to refer to the NXG FpCfg XML

document for more information and also to contact Allied Electronics for specific
questions.

11.3.7.5 Fueling Point Specific Controls

The controls found in the left pane are those associated with each fueling point entry in
the XML file. Note well that the Fueling Point combination box is inhibited and is
“grayed out” when a fueling point has been selected in the right pane. This is because the
fueling point number is used as an internal “key” to refer to that particular entry.

Other than the fueling point, all other controls are available to the user.

Nota Bene: The FpCfg Builder form does not check the validity of your entries.
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11.3.8 Get Config

The Get Config command issues a series of ANDI commands and prepares a text report

of their contents.

The commands issued are:

ANDI Command

Description

SSCO00 EQ0 Controller Firmware Version

DIS00 S00 Dispenser Firmware Version

DPTO00 O00 DPT Firmware Version

DPTO00 O80 IPT Firmware Version

RFAQOE ... Read the length of the FpCfg.xml file to determine if it exists on the
controller

DIS00 P Site Configuration

DIS00 NOO Dispenser Configuration

DIS00 V Blend Ratios

DI1S00 R0O0O Fuel Price

DPTO0 K DPT Configuration

DPTO00 k10100 Get DPT Display Prompts

DPT00 W00 IPT Configuration

DPT00 EO Fuel Information

DPTO00 GOL1... Product Information (reads all of them)

FIMOO B Tank Gauge Configuration

DGSO00 P ANDI Firmware Modules

The file created is named config_info.txt

When all the aforementioned commands complete, the file is loaded automatically with
the Windows Notepad application.
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11.3.9 Make Config

Similar to the Get Config, the Make Config command issues a series of ANDI
commands, but instead of creating a report it creates the appropriate configuration
commands in a text file. This feature is useful for copying and preserving your
configuration.

Following is a list of the commands sent and built by the Make Config feature:

Command Sent | Command Created | Description

DIS00 P DIS00 O... Site Configuration
DI1S00 NOO DIS00 M... Dispenser Configuration
DIS00 V DIS00 U... Blend Ratios

DIS00 RO00 DIS00 Q... Fuel Price

DPT00 K DPTO00 J... DPT Configuration
DPT00 W00 DPTOO V... IPT Configuration

The file created is named Config_cmd.txt

When all the aforementioned commands complete, the file is loaded automatically with
the Windows Notepad application.

11.4 DPT Printer Test

Often it is necessary to test the functionality of DPT or IPT printers. In order to do so, a
command has been added to send a fixed text message to the selected payment terminal.
The DPT/IPT is selected using the DPT/IPT combination box, and then the command is
issued by pressing the Send button.
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11.5 Dispenser State

The state of the dispensers can be displayed continuously in real time by pressing the
Display command button.

That will cause the following form to be loaded and a subscription sent to receive
dispenser status notifications.

— Dispenser State

e b

FPO1 |FP 02 |FP O3 |FP 04 FPO5 |FP 06 |FP 07 |FP 08

Note that this form will automatically size itself (in banks of 8) depending on the number
of fueling points that are configured.

The state of the fueling point is depicted by a change in the appearance of the icon, as
well as indicated by the Tool Tip Text displayed when the mouse pointer is hovered over
the individual fueling point.

Following is a table of the icons along with their corresponding state:

Mot confi mured H Offline a Idle

Calling Reserved E Authorized

Dispensing n Suspended

Payahle Clamed

2} =) =) =
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12 System and Port Status Tab

This tab presents the user with information concerning the state and status of the
communications ports (16 in the SSC, up to 64 in the NeXGen) and displays critical
information about the system itself, such as firmware type and revision, et cetera.

When you select this tab, it sends a message to the controller to automatically update port
status whenever it changes. When you click to another tab, it disables the automatic
message. You can get the status information at any time by pressing the Get Status
control.

Allied Diagnostic

File Trace Edit Help

Caonnection Communications Commands Utilities
Port Status

Part Function State Statug e’

POS Disconnected | CTS & DSR Not Active

2 POS Discannected CTS & DSR Mot Active

3 MEL Disconnected CTS & DSR Mot Active

4 TLS YWaiting Link ldle {Awaiting Config)

5 DI Active Tirneout (Mo ACK/NAK) Errar

B DI Waiting Link Idle {Awaiting Config)

7 MO Mot Used Port Mot In Use "

System Infarmation

You are connected to the Allied Electronics MexGen Systern on the 84500 platform
Itis running program MOMNBO00N Few 10

Get Status

Response Received 04-Apr-14 08:58:44
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13 Automatic DPT R Processing

With version 4.0.2 the ability to process DPT R (card authorization) commands has been
added to DGS.

This feature provides the means to supply data to incoming DPT R commands as well as
to send prompt completion codes automatically or interactively and specify a final
completion code for the transaction.

Prior to use, the authorization parameters and prompts to send must be configured. To
facilitate this action, a Dpt Automatic Authorization Settings form has been included.
You can load this form by pressing on the Auto DPT R command found on the
Commands tab.

Following is an image of the Authorization Settings form:

Dpt Automatic Authorization Settings

File

{ Authanzation Parameters || Prompts bo Send

Tranzachon Type

|gnore and Leave it Blank w

Tranzaction Smount
10000

Dizcount & Prompt | Dispenser Limits | b axirmum Volume
Yending Statuz | Hose List | Messages | Fees and Balance

= &l () Fuel Only
[ "Wash 1 [ wash 2 []wash3 [] washd
[ washs [ 'washE [ 'wash? [ ‘wash®

] Restrict Washes

Language Ireeoice Mumber

Englizh [E] W
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The form is divided into two sections: Authorization Parameters (those sent to the
controller) and Prompts to send (a collection of completion codes sent to collect specific
data).

Nota Bene: The prompts sent in response to the DPT R command tend to be application
specific. We have attempted to include all supported prompts. Contact Allied
Electronics for questions or clarification on the support of specific prompts.

Following is a table of the various parameters that can be sent to the controller:

Parameter | Description

Transaction | Set by the controller or the POS, it describes the type

Type information (Cash, Credit, Split tender, et cetera).

Transaction | The maximum dollar amount of the transaction.

Amount

Vending Restricts or frees purchase of items other than fuel and provides
Status the means to restrict specific car wash selections.

Hose List Enables, inhibits, or causes the user to be asked to confirm the
purchase of fuel on a hose-by-hose basis. The data are ignored
if the Send the Hose List box is unchecked.

Display If populated, the text in this control will be shown to the user
Message after all fleet prompting and before the dispenser is authorized.
Receipt If populated, the text in this control will be printed on the trailer
Message of the receipt.

Fee A Transaction fee to be applied. The dispenser authorization

amount will be decreased by this amount if supplied.

Remaining | The funds remaining on a card. Not all systems use this field.
Balance

Remaining | The remaining number of times that a card can be used. Not all
Uses systems use this field.

Single Use | The amount of money that can be spent in a single use of a card.

Balance Not all systems use this field.

Discount The discount method and amount used in the transaction. See the
Rule ANDI POS Specification for more information.

Prompt The prompt mode, field type, and key list used in the transaction.
Rules See the ANDI POS Specification for more information.
Dispenser Product-by-product amount limit.

Amount

Limit

Dispenser Product-by-product volume limit.

Volume

Limit
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Parameter | Description

Maximum | The maximum amount of fuel that can be dispensed in the
Fuel transaction — regardless of grade.
Volume

Language Selects the language used for this transaction — when complete
the language is restored to that which was in use.

Invoice The invoice number to be applied to the transaction.
Number

Moving on to the Prompts to Send panel we see the following:

Dpt Automatic Authorization Settings EI

File

Autharization Parameters

On Receipt of a OFT R grompt far the following:

[] ZipCode [ [] Hubometer ]

[] Enter PIN or Ma For Credit ) [] Select Credit or Debit ™
[] INTERALT Sequence [ Purchase Order _

[] Trailer Mumber . Driver Mumber d

[ Trailer Hubometer - [] Driver and Odometer |
[] Additional D ata Mesded = [] Odameter o

[ 1D Mumber < [] PIM Code p

[ Swipe Card and re-submit 7 [] wehicle Humber w

[ Keep‘waiting 'w [[] Customer Code {

[] Contral or Trip Mumber [

Cycle automatically through the above items

Final Response

Accepted A - Clear Al

Note the Cycle automatically through the above items control which when checked will
cause DGS to send the prompts in the order found above and then finally answering with
the completion code set in the Final Response combination box.

The Clear All command is used to deselect all the checkboxes.
Additionally, one can load and save INI files containing specific configurations by using

the eponymous menu items.
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Assuming that any of the prompts are selected, upon receipt of a DPT R command the
following form will be displayed:

= Credit Transaction

Transaction Information

Token 00 DptStatus = Dpt 07 Dis 01 Number 00116 Status: Approved T1 Present T2 Present
3

Date Time = 17-Dec- 2015 16:14 Transaction Amount = 10000 Transaction Type = Credit Sl

Accuired Data
Barcode' Customer / Member [d ?
Control Number * Odometer O
Customer Code < PIN Code P
[ Il |
Driver Mumber G Purchase Order +
[ [ |
Hubometer . Wehicle Number f
Irvoice Mumber J ZIP Code =

Sending Driver

Note that the status bar at the bottom contains “Sending Driver.” At this point the DPT is
prompting the user to enter the driver number.

The user will then enter his data and then the following form is displayed:

« Credit Transaction 9 [=1]E3]

Transaction Information

Token 00 DptStatus = Dpt 01 Dis 01 Mumber 00116 Status: Approved T1 Presenl t T2 Present
Date Time = 17-Dec- 2015 16:14 Transaction Amaunt = 0010000 Transaction Type = Credit Sale

Acquired Data

Barcode ' Customer / Member Id ?

Contiol Numbsr * Odometer 0

Customer Code < FIN Code P
1 Il |
Diver Nuriber G Puichass Order +
‘ i
| 2309 | |
Hubometer . Wehicle Number f

Irvvaize Number | 2P Codz =

Sent Final CC af A

The data are displayed and then the transaction is approved. Note that if the automatic
prompting is un-selected the Next Prompt, Approved, and Decline commands are
enabled.
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14 Utilities Tab

The utilities tab contains features accessed more infrequently. They are grouped
logically in frames of Communications Related, Port Monitoring, Firmware Control, and
Port Sniffer.

Allied Diagnostic =3
File  Trace Edit Help
Connection Carmunications Cormmards Status

Communications Belated Port b onitoring Firrmware Control
Cormpact Flazh

Part Statistics Port Sniffer Access Mode
Chan 1 v ) RFA
@

14.1 Serial Line Control

The Serial Line Control command loads the Serial Line Control form. This form presents
an interface to monitor the state of the CTS (Clear To Send) and DSR (Data Set Ready)
lines, It allows one to toggle the write-only (RTS) Request To Send and (DTR) Data
Terminal Ready lines, and it provides a means to send the protocol control characters
across the serial line. This form has no effect when disconnected or connected via
Ethernet.

14.2 Ping

The Ping control is used to send an ICMP echo message. If there is an entry in the
Device Name control, it will try to ping that node. Otherwise, it will simply load the Ping
form for subsequent use. This is an alternate route to the Ping command and that it
behaves exactly like the one on the Connection tab.
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14.3 Port Statistics

The Port Statistics controls enable you to prepare a report of activities for a specified
communications port. The combo-box is used to select the port of interest (1 through 16)
and the Get Statistics command button sends the appropriate command and causes a
report form to be loaded on completion.

Following is an example of the prepared report.

File Edit Format View Help

Port statistics: )
Port number 01

Last reset 01 Jan 70 00:00:00
Data Set Ready = True

Clear To Send = True

Buffer slots in use = 0
Messages sent = 00000031
Transmit NAKs = 00000
Transmit DAKs = 00000
Transmit aborts = 00000
Transmit failures = 00002
Transmit timeouts = 00000
Messages received = 00000031
Receive NAKs = 00000
Receive DAKs = 00000
Receive aborts = 00000
Framing errors = 00000
Overrun errors = 00000

Parity errors = 00000

Message length errors = 00000
Checksum errors = 00000
Receive timeouts = 00000
Disconnections = 00000

With the release of version 3.2, one can now reset these accumulated statistics as well.
14.4 Listen/Unlisten

The Listen/Unlisten command toggles back and forth according to whether DGS is
listening for an incoming connection request or not.

With the release of 4.0.4 this feature was introduced. Using the Local IP address and
Ethernet Port, one can rig DGS to accept an incoming connection request from an
appropriately configured forecourt controller. Not all Allied firmware supports this
feature, so contact Allied Electronics Technical Support for more information.
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145 Configure Port Monitoring

Invoking this command loads the following form:

Source Port File: Rallover

L |rfinite L

Destination File

CASMDI_DGS M anitarsGil Crindhchannel?. ma

[ Ok ] [ Cancel ]

The Port Monitor form sets up the parameters used for the monitoring command.
The Source Port is enumerated on sign on, so you just select the port of interest.

The File Rollover control provides the means to select how long data are written to a
particular file. The default is infinite, meaning that the data are always written into the
file specified in the Destination File control. Alternatively, you can elect to write into a
file for a period of time. By specifying a file rollover time, your file name will be
appended with an underscore (_) and three digits starting with 001. With the elapse of
the file rollover time, the file number will increment.

For example: Specifying C:\DataFiles\CreditHost.Mon would result in the creation of
C:\DataFiles\CreditHost_001.Mon and then C:\DataFiles\CreditHost_002.Mon — and so forth...

The Data Capture control specifies which of the data are saved.

The Destination File control specifies the file into which the data are written, with the
understanding that if File Rollover is selected the underscore and three digit file number
will be concatenated to the name.

Pressing OK will save the parameters; Cancel will abandon your edits.

14.6 Start / Stop Port Monitoring

This command button toggles starting and stopping the port monitoring operation based
on the parameters specified in the Configure operation.
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14.7 Download Command

Pressing the download command causes the Download Program form to be displayed.

¥ Download Program

File: to Download
[ walidated Executable
Target Local Mode
Load the new program. .. (%) immediately
or..
() &t the very nest idle period (3 at the very nest forced idle period
or..
) at the nest idle period (3 at the nest forced idle period
after...
2014 Apr 04 D859 &

The File to Download text box allows one to type in the name, or one can use the Select
command to browse with a dialog box to find the firmware file to be downloaded.

With the migration to PA/DSS the executable delivered to the controller must be
validated to ensure that it came from Allied Electronics. In order to do so, a special INI
file is included with the executable which contains an encrypted checksum of the
executable. To enable this feature, check the Validated Executable checkbox and
specify the appropriate INI file. This file is normally in the same directory as the
executable and they travel in pairs.

The target load mode controls allow the user to select how and when the device will load
this new binary image. Several options are available, which are mostly self explanatory.
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One sets the date and time using the after... control, of which the minimum is the current
date and time.

Once the salient parameters are in-place, you press the Download button to start the
downloading operation.

The Status frame contains a status message and progress bar to keep the user up-to-date
on the progress. Understand that downloading the firmware via the serial port is slow, so
please be patient.

Nota Bene: You should ensure that the time in the controller is synchronized to the PC if
you are going to employ a timed download.

14.7.1 NeXGen Post-Download

In the NeXGen environment, downloading new firmware brings with it the burden of
ensuring that the existing executable file is not trashed on the compact flash. To
minimize the chance of corrupting the existing file, new firmware is written to a
temporary directory and then the executable is renamed rather than writing the executable
block by block.

After the download session ends, the firmware recognizes that a new version is present
and starts the updating process. This involves renaming the file in the temporary
directory so that it becomes the new application and then restarting.

As this is underway, a form is displayed on the PC so that the user can track the progress.

#¢ Firmware Lipdating E|
[
o .
. - NexGer

Do not turn off the power to the NeXGen
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The preceding screen shot shows a static picture of the process. In actual operation, the
yellow bar will appear to travel between the disk and the NeXGen icons.

Once the firmware has been renamed, it will then start automatically the reboot process.

During reboot, the post-download status form will continue to monitor the progress and
when complete, a dialog box will be displayed with the end status.

)

% Firmware Reloading

(@ O
o
———— - NeXGen

Checking the installation status

If in the event that this process fails, the status monitor form will close itself after a
period of time. You may also close the form by clicking on [X].

Nota Bene:

Users are most strongly cautioned to follow carefully the upgrade instructions.

You simply cannot download the files and cycle the power on the NeXGen.

Under certain conditions during the reloading phase, there is a step in which the internal

Static RAM is cleared, which takes a few moments.

If you deviate from the process, you might render your NeXGen unbootable.
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14.8 Reset

Invoking the Reset command loads the following form:

7 Reset

X

Feset Type
) ‘Warm Start
O Cold Start
(0 ResetDispensers
) Restart Application
() Boot Diagnostic

Feset Mode
® Immediately O Atldle
[] After
Ik, | | Cancel

One should select the type of reset and time in which the reset is executed then press OK
to perform it or Cancel to abandon the operation.

The Reset Type options are:

e Warm Start
Causes the controller firmware to reset without losing your configuration
e Cold Start
Causes the controller firmware to reset and clear your configuration data
e Reset Dispensers
Causes the controller to clear everything except credit card table data
e Boot Diagnostic
Causes the serial loopback diagnostic application to load at reset
e Restart Application
Causes the configuration and credit host specific data to be cleared at reset
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Reset Mode specifies whether the action should be undertaken immediately or the next
time that the station is idle (no pumps operating).

With version 4.0.5 the ability to direct the ANDI controller to schedule the reset
operation at a future time has been introduced. To use this feature, one must check the
After control and enter the date and time in the control immediately below the checkbox.

Not all firmware supports this feature, so feel free to contact Allied Electronics for more
information.

The default setting is for the reset operation to happen immediately. Note that the date
and time control becomes enabled once the After checkbox is checked.

The Reset command is limited to administrative users in PA-DSS compliant systems.
Nota Bene: For NeXGen users connected via Ethernet, you must reconnect once the

device is back up and running, as virtual POS connections cannot be maintained across
boot cycles.
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14.9 SRAM Access

The NeXGen platform is outfitted with a Static Random Access Memory (SRAM)
module which provides data integrity across primary power failures. DGS provides a
means to manage this sub-system by way of a dedicated form which is loaded by pressing
the SRAM Access command button.

The SRAM sub-system is designed to look like a disk drive with a file system. It
contains a root directory with either one or two folders. The first folder, (Allied) contains
system related files; the second folder, (named for the specific application) contains the
files specific to the application and credit card host.

Access to the SRAM sub-system is limited to read-only; files are created, read, and
written by the firmware.

When the form loads, it automatically submits commands to the NeXGen to read the
SRAM module information and the directory structure. The response to these messages is
written into the Module Information and File Structure frames. These commands can be
sent manually by clicking the appropriate menu entry.

One can select a file for upload by clicking on it in the File Structure control. If you
double click the file, it will select it and upload it your PC in one operation.

The Module Information frame lists the particulars of the SRAM module. The key field
is whether or not the device is present. The Size, Bytes Used, and File System Version
are all dependent on the firmware.

The File Structure frame contains a Directory Tree control which is used to select your
file of interest. Information about the selected file is written into the File Information
frame. Aside from the file name, the file’s index into the SRAM data space, the amount
of memory reserved, and file length (amount used) are provided. In the case where the
file entry is a directory, the maximum number of file entries and the current number of
entries in use is also provided. For files, these two fields are zero.

When uploading files, bear in mind that the files will be stored on the current hard drive
in the path as they appear in the File Information frame. For example, in the following
screen shot, were you to click File = Upload, the file C:\Allied\AdsConfigFile would be
created and populated from the SRAM sub-system.

SRAM file read operations are not supported in PA-DSS compliant systems.
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- Static RAM Management

File  Module

Madule Information

The Device iz present

SRAM Size = 2097137

SRAk Bytes Uzed = 526814
SRAM File Syster Version = 10010

File Structure

>

Cchk.epFile
CardFile
FromptFile
FroductFile
TrrFile
DgzFile
RifiFilz
DizBlendFile
DizConfigFile
DizFile
NizPrireFile

(<

File [nformation
Mo File Selected
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14.10 CF Access

The CF Access command button loads the Compact Flash Configuration control panel,
which it detailed later in this document. One must be connected for this control to be
enabled.

14.11 Port Sniffer
The Display command button loads the Port Sniffer’s control panel. The Start and Stop
command buttons send the start and stop commands to the Sniffer firmware. The Sniffer

utility is detailed later in this document.

Nota Bene: The start and stop commands have no effect unless you are connected to a
NeXGen with sniffer firmware.
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15 Port Sniffer Utility

The Port Sniffer utility provides a means to intercept and forward the communications
stream between serial devices. When troubleshooting communications between devices
it is often preferable to do so using an independent piece of hardware. The SSC and
NeXGen platforms both offer port monitoring, but with the understanding that one end of
the hardware pair is also acting as the collection vehicle. The port sniffer addresses that
concern by monitoring the traffic in a totally non-intrusive manner.

Nota Bene: The port sniffer software is used in conjunction with NeXGen hardware
running DSA class firmware. Contact Allied Electronics for details on how to obtain the
necessary hardware, firmware, cables, et cetera.

15.1 Theory of Operation

Data are transmitted and received from the controller, SSC or NeXGen, using a variety of
serial interfaces. Regardless of the specific method or protocol, it is converted into ones
and zeroes. This is the point at which we can tap into the communications stream, grab
each byte as it passes, and transmit it via RS232 to the sniffer hardware.

On the SSC platform, one can install an RS-232 Adapter board between the main board
and the communications board in question. Cables coming from the adapter are plugged
in to channels 1 and 2 or 3 and 4 in the NeXGen sniffer hardware.

NeXGen sniffer hardware differs from that used in forecourt control only in that it
contains firmware specific to the acquisition and retransmission of serial data.

Your NeXGen sniffer hardware must be connected via Ethernet to the PC on which the
DGS application is executing.

You would then use DGS as the control and repository for the sniffer data.
Note that you can run multiple copies of DGS simultaneously. You can have one instance

shooting commands back and forth to the controller, and another instance acting as the
sniffer controller.
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15.2 Port Sniffer form

Below is a screen shot of the Port Sniffer form:

Port Sniffer

File  Sniffer  Interpret  Help

Mavigation
L G B T bR P e Byte By Byte Reference Point

3
Buffer and Display Contral

Format Select Buffer I_ i ‘

Bytes Pair1: - = o
(& HEX O asCl [ Freeze ] [ Clear ] [SetTHel ] ytes Pair | _: Bytes Pair 2 .
Port Time: Status Eivte Yalue EBuffer Mum

This form is the main interface to the port sniffer facility. Data coming in over the
various ports are stored on repeated lines that scroll as needed.

Data are displayed as:
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... Up to 8 times

It provides data visualization, sniffer control, buffer navigation and control, data format,
and load and save capabilities.

15.2.1 File menu controls

This menu section controls the load, save, and editing operations of the data, as well as
presents an option to exit from the form. The operations are self explanatory, although it
bears mentioning that if one edits a live file, the data in the buffer are unaffected. When
saving the data, a copy is made of the memory buffer and then it is written to disk.

If a load operation is attempted with data in the buffer, a warning is issued with the
option of clearing the buffer before proceeding.

With the release of version 3.0.7, a formatted output was introduced that writes the
sniffer data arranged similarly to the display. Unformatted output data use the .dat suffix;
formatted data use the .txt suffix. One can view either type with the built-in Notepad
session, but the Load operation is limited to loading raw, unformatted data. It is
important to understand that if you ever want to reload our data, save it in unformatted
form; you can always save it in formatted form after the fact.

Following is an example of the formatted and unformatted output files:

B Sniffer.txt - Notepad [Q

Edit Format View Help

File
CH 1:
oH 2:

CH 1:
CH 2:

CH 1:
CH 2:

CH 1:
CH 2:

CH 1:
CH 2:

CH 1:
CH 2:

CH 1:
CH 2:
CH 1:
CH 2:
CH 1:
CH 2:

CH 1:
CH 2:

CH 1:
CH 2:
CH 1:
CH 2:
CH 1:
CH 2:
CH 2:

CH 1:
CH 2:

CH 1: &

26 28 20 20 30 26 20 20 E2 20 Sg B2 76 20 20 22 29 B2 £2 43 20 20 20 41 £2 £2 42 20 20 30 36 42 B2 E7 44 49 B2 44 £0
54 43 43 48 46 48 40 F7 95 63
86 B2 20 3@ 30 32 33 53 53 43 09 36 41 41 44 47 53 30 308 30 33 44 47 53 52 46 41 4C 4F 47

f4 5A 83 B B2 77 38 30 33 34 52 46 41 39 36 20 43 38 32 31 30 5C 40 4F 42 49 4C 5C 52 45 56 A3 00 @1 30 38 30 36 59 38

3A 3@ 3@ 34 FA BB A3 A6 @2 T3 30 3@ 37 3@ 53 53 43 30 3@ 4E
A6 B2 21 30 3@ 31 3@ 52 46 41 3@ 34 63 43 36 3@ 3@ CF DS @3

4B 42 42 42 90 26 20 20 20 37 20 32 32 32 21 20 20 26 24 32 4C 4E 20 21 20 52 65 F1 TS EE 73 P4 69 6E €7 20 42 &1 72 &4

26 54 61 62 BC 65 20 20 26 20 20 20 26 20 20 26 20 20 20 26 20 20 20 20 ES D4 832 0 @2 79 36 32 22 34 C2 46 41 3@ 37 20

44 2@ 32 21 36 EC 40 4F 42 49 4C BC 43 41 B2 44 £2 2E &4 40 £0 A2 80 01 20 20 28 20 20 230 26 32 24 24 46 42 4F &2 4D 26

121 20 30 26 20 20 20 20 20 20 26 20 20 20 260 20 20 20 20 20 20 26 20 20 20 32 22 4B 26 20 20 20 4E 20 20 28 30 20 290 26

S0 38 30 36 09 36 29 20 20 20 20 20 20 20 20 20 20 26 20 26 29 26 29 20 20 20 20 4E 4E 30 35 30 39 39 30 39 39 30 38 20
20 28 20 268 29 26 209 20 20 20 20 20 20 20 20 20 20 26 20 26 29 26 290 30 4E 4E 4E 30 30 32 37 30 37 36 34 39 37 30 37 36
38 35 32 46 4F 268 33 44 49 2@ 33 45 36 31 39 35 35 20 2A 26 20 20 20 20 20 PA 2A 2@ 20 20 26 20 2@ 2A 28 PO 20 28 2@ 26
20 26 20 20 20 26 20 20 26 20 20 20 26 20 20 26 20 20 20 26 20 20 20 20 20 20 26 20 20 20 26 20 20 26 20 20 20 26 20 20
20 26 20 20 20 26 20 20 26 20 20 20 26 20 20 26 20 20 20 26 20 20 20 20 20 20 26 20 20 20 26 20 20 26 20 20 20 26 BC F9
85 B2 FA 20 22 22 24 B2 46 41 20 22 28 44 20 32 21 36 &C

2
Be B2 22 20 20 21 20 B2 46 41 20 27 41 44 22 24 24 64 EE B2
40 4F 42 49 4C EC 42 41 52 44 £3 2E &4 40 56 A2 20 @1 20 26 20 20 32 24 24 22 24 24 46 42 4F 52 20 268 21 20 30 26 20 26

)X

BREEEEEE B WEEZISECOE ASSCEBUECRUWDISOR
TCCHFIM

BA2355CABARDGESAAE 3DESRFALOG

wBB34RFABE CB216-MOBIL~REV  BO8008

anadz #BAETASSCABN

tA61 BRFABACCAAA
KCCHaoeaarez22180542LHM01 Regquesting Card
Table yE224RFAGT

D2 16~MOBIL~CARDE. TMP BEEEEEE244FCORM

180BEEHEEE 28K BHEBEEEEE
BeaEaa HHEBEEEEEEEE
BANHHBEZPATE4I7PEFE

852F0 301 3EA1955

2B224RFABE DOZ216~
381 BRFAETADZ44dY

MOBIL-CARDS. TMP BE0E244244FCOR  1EBRGG

A
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B Sniffer.dat - Notepad
Eile Edit Format Yiew Help

A1 .3409741636.60,.02 ~
A1 ,.3489741636.608,.21
A1 .3489741636.68,.30
A1 .3489741636.668,.30
A1 .3489741636.668,.32
A1.34A9741636.068,. 30
81 .3409741636.608,.53
A1 .3409741636.60,.53
91 .3489741636.608,.43
A1 .3489741636.68,.20
A1 .3489741636.68,.20
A1 .3489741636.68,.20
A1.34A9741636.008,. 41
A1 .3489741636.688,.58
A1 .3409741656 .08, 4F
91 .3489741656.668,.53
A1 .3489741656.668,. 30
81 .3409741656.608,.31
A1 .3489741656.6808,.30
81.,34092741656.08,32
A1 .3489741656.88,4C
A1 .3489741656 .08, 4F
91 ,.3489741656.608,47
81 .3489741656.608,.52
81 .3409741656 .60, 46
A1 .3489741656.668,. 41
81.,34092741656.08. A7
81 .3489741656.68,.73 3

Note the file format:
Port, Time Stamp (in milliseconds), Status (Hex), Data (Hex) <CR LF>
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15.2.2 Sniffer menu controls

This group provides a means to start, stop, and configure the operation of the sniffer
firmware. The firmware remembers the last communications settings, so it can be pre-
programmed for specific operations and then simply turned on in the field.

The configure menu option loads the following form:

1_Sniffer Configuration E]

File  sSniffer Settings

Port Pair

(%) Ports 1 and 2

() Ports 3 and 4

Baud Rate Data Bits
“ w

Farity Stop Bits
w -

Frezet Devices

Daone

This form provides the means to set the communications parameters for a port pair. The
Sniffer Settings group reads from and writes to the firmware; the file group reads from
and writes to the INI file used by DGS.

The Preset Devices combo box provides a means to quickly set all the communications
parameters of commonly used devices.

Nota Bene: Your settings are not sent to the controller until you press the Sniffer
Settings 2?Write command.

15.2.3 Help group

The About command loads a dialog box showing information specific to the version and
configuration of the sniffer utility.
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15.2.4 Sniffer Form Controls

The Data display window shows up to 90 characters per line when in ASCII mode and 30
characters per line when in HEX mode. There are 8 complete lines of text available for
display at any point in time.

Right clicking on a character makes that character the zero time reference; subsequent
left clicks cause the status bar at the bottom of the form to display the port, time received,
status, and data (as ASCII and HEX) for the character. It should also be noted that the
very first click, regardless of which button was pressed, will result in that byte being
selected as the reference byte. You can always reset the reference byte with a right click.

A word about the reference byte: This facility provides a means to determine the time
difference between any two bytes. It is bipolar, in that it works in both the positive and
negative directions. The format is presented to the user as a combination of days, hours,
minutes, seconds, and milliseconds depending upon how large the difference.

The Navigation frame contains those controls that allow the user to move about the
buffer space. The Percent of Buffer control acts like a coarse tuner; you can zip from
one end to the other rapidly. The Byte by Byte control acts like a fine tuner; moving you
one byte at a time. The Latest command pegs the Percent of Buffer and Byte by Byte
controls so that the last message we received will always be displayed. The Reference
Point controls (Set and Go) provide a means to remember a specific position in the
buffer and return there respectively.

The Buffer and Display Control frame contains those controls that are used to affect the
data buffer, as well as if and how the data are rendered in the display. The Format frame
offers the user the choice of displaying the data as ASCII or HEX.

The Select Buffer control navigates through the temporary buffers. Temporary buffers
are created automatically when the number of bytes received exceeds the size of the
memory resident buffer. The Navigation controls remain the same irrespective of the
buffer-in-use.

The Freeze button, when pressed, stops new data from being added into the display. It
then turns into the Thaw button, which when pressed, resumes rendering new data into
the display. The Clear button erases all data in the buffer.

The Bytes Pair 1 and Bytes Pair 2 controls simply list the accumulated bytes received
over the channels.

The form also contains a status bar that lists the port, time, status, and data received
whenever one clicks over a byte in the display.
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15.2.5 Protocol Interpreters

As the SSC and NeXGen support an enormous suite of peripherals, keeping track of the
varied protocols is a significant challenge. To help ease this burden, DGS contains a
collection of protocol interpreters that take Sniffer Data as an input and return human
readable text representations of the various messages.

For the most part when troubleshooting, data are acquired through the Port Monitoring
facility. In their native form, these data are not of the format required for the sniffer. Not
to worry, as there is a command to import the monitor files into the sniffer. Once aboard,
the data can be subjected to interpretation.

Currently, the suite of protocol interpreters includes:

Bennett Dispenser
Gilbarco CRIND
Gilbarco Dispenser
Orpak OrSPT

Wayne CAT (DUKPT)
Wayne CAT (MLKH)
Wayne Dispenser

More types are forthcoming.

At this point, the interpreters assume transmit data on channel 1 and receive data on
channel 2.

Contact Allied Electronics for more information and assistance.
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16 Compact Flash Management

The NeXGen hardware platform uses Compact Flash technology in place of the code
boards used by the Station Site Controller. The compact flash (CF) provides storage for
the boot-loader and monitor, the firmware application (NEXGEN.EXE), graphics files
for download, a download directory for updating the firmware application, a reset log,
and a NeXGen.INI file. The purpose of the Compact Flash Configuration facility is to
manage these resources.

Compact Flash file access commands are limited to administrative users in PA-DSS
compliant systems.

Following is a screen shot of the Compact Flash Configuration form:

g Compact Flash Configuration

File

Port and Board Assignment Ethernet Settings
Port Function |10 Board P Address Sub Met Mask
Part Ta Configure Port Functions
COm1 - Factory default - Gateway Address

Use DHCP [default)

Change Port l

Restore Defaults l l Wiew Al l
Apply Changes
Apply Changes

File Transfer

“four Computer Files Compact Flash Files
ADODE.dI -~ "] -~
= AlliedCommConfig.ini
() DGS_DOT_NET AlliedCammTrace. bt NEXGEN
=177 bi ANDI_DGS.exe
-—'-,bﬂ ENDI_DES. ene. config DISKKERN BIN
=) Release ANDI_DGS.pdb WEXGEM.EXE
=1 o | ANDI_DGS vshost exe 5
(5] Documentation ANDI_DGS. vshost exe.confir IMG
ANDI_DGS. vehost exe. manif - DOWMLOAD
ANDI_DGS. xral © RESET
config_cmd.tst
config_info. bt w0 ML

< ? | devices.tmp b PO

The Compact Flash Files control allows users to upload and download files through File
Transfer Protocol (FTP) and Remote File Access (RFA). The Port Assignment panel
provides a means to assign port function explicitly. The Ethernet Settings panel provides
a means to specify those settings explicitly.
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16.1 Port Assignment

The function provided by the communications ports on the NeXGen can be reassigned on
the fly by this facility provided it is done so within compatible hardware.

For example: if a current loop channel were to suffer damage you could move the cable
to another unused current loop channel, reassign the port to that new hardware, and
restart the NeXGen.

When the form is loaded, the current settings and any reassignments found in the INI file
are read from the device.

The Port to Configure control sets the port to which any changes you make are applied.

The Port Functions control provides a list of functions that are available for assignment.
This control is populated by an internal list of constants contained the ANDI
Communicator Object. If your port type is not found, it will warn you and the combo
box will contain the best approximation of the port function that we can muster. You
should contact Allied Electronics for an update to DGS should this happen.

The [?] command generates a list of the currently supported port types.

The Change Port command assigns the currently selected Port Function to the currently
selected Port to Configure.

The Restore Defaults command returns all ports to their factory default.

The View All command creates a report of all the settings in the Ports.tmp file and
displays it using NotePad as illustrated below:

B Ports.tmp - Notepad r-_lrEIR_]

Eile Edt Format Yiw Help

Port Configuration Information:

Fort Funclion

COMI Factory default
COMZ  Factory default
COM3 Factory default
COM4 Factory default
COMS  Factory default
COME  Gllbarco dispenser
COM7? Gilbarcn CRIND
COME  Factory default
coM3s Factory default
COMIN  Faclory defaull
COMIT  Factory default
COM12  Factory default
COMI3  Faclory defaull
COMIA  Factory default
COM1S  Factory default
COMIE  Faclory defaull

Clicking the Apply Changes button writes the changes for the ports into a local
NeXGen.INI file and then transfers that file onto the Compact Flash.
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16.2 1/0 Board Settings

Setting up the 1/O boards is accomplished in the 1/0 Board tab in the Port Assignment
frame, as illustrated below:

I4 Compact Flash Configuration

File:

Part Function I"JD

Board
v

Tppe

Fort and Board Assignment
e

Address
- “

IRQ
w

Change Board

Restore Default:

[ Wiew Al ]

File Transfer
“r'our Computer Files
C:
[] DES_DOT_MET
=17 bin
= r_|‘" Felease

_|" Dacumentation

Apply Changes

ADODE.dIl

AlliedCommConfig.ini
AlliedCommT race.tt

ANDI_DGS exe

AMDI_DGS exe.config

AMDI_DGS pdb

AMDI_DGS vshost.exe
AMDI_DGS vshost exe confi

AMDI_DGS vshost exe.manif

Ethernet Settings

IP Address Sub Met Mask

Gateway Address
Use DHCP [detault)

Apply Changes

Compact Flash Files
= -~
NEXGEN
DISKEERM.BIM
HNEXGEN EXE
i MG
3 DOWNLOAD

ANDI_DGS =ml
config_cmd ket
config_info.txt
< > | devices.tmp e’

= RESET
sl ML

In addition to setting the port types, the 1/0O boards can be reconfigured in the field by INI
file entry. The 1/O Board tab provides an interface to build these file entries.

There are 3 1/0 boards that can be configured. The board to configure is selected using
the Board combo box.

The Type of 1/0 board is selected by the Type box, which selects the actual hardware
which will be mapped to the board previously selected.

The Address and IRQ combo boxes set the physical address and Interrupt Request
number used for the selected board.

Similar to the Port Function tab, the [?] command on this tab generates a list of the
currently supported board types.

Feel free to contact Technical Support at Allied Electronics for guidance.
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16.3 Ethernet Settings

The Ethernet Settings panel provides a means to effect changes to the Ethernet address of
the NeXGen by way of the NeXGen.ini file.

This control essentially provides the same functionality as the ANDI TCP D command,
which can be found in the NeXGen TCP/IP Interface document.

When the NeXGen firmware starts, it looks on the compact flash for the NeXGen.INI
file. That file can provide static IP addresses for locations where Dynamic Host
Configuration Protocol (DHCP) are either unavailable or undesired. The default setting is
DHCP.

Should one want to explicitly configure the network settings, one would first de-select the
Use DHCP option button. This enables the IP Address, Sub Net Mask, and Gateway
Address text boxes, which are inhibited under DHCP.

If one chooses to set the addresses, the IP Address and Sub Net Mask must be specified.
The Gateway Address is considered optional.

The Apply Changes button writes your control settings into a local NeXGen.INI file and
then transfers that file to the Compact Flash.

Nota Bene: When connected serially, this is the only functional tab in the Compact Flash
Configuration form. When the form is loaded, it will issue vicariously a TCP D
command to read the programmed parameters, filling in the controls with the data
gleaned. Pressing the Apply Changes command will then write them using that same
TCP D command.
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16.4 File Transfer

The file transfer facility allows you to upload and download files from your computer to
the compact flash device in the NeXGen.

It uses the File Transfer Protocol (FTP) service for systems up to PA-DSS 1.2 and
Remote File Access (RFA) for all others.

For PA-DSS compliant systems, it employs the username and password supplied when
you sign on to the controller. You do not need to specify a username or password for
non-PA-DSS compliant systems.

Nota Bene: Exercise extreme caution when uploading and downloading files to and from
your NeXGen. Prior to carrying out your request, DGS will prompt you to confirm the
operation by way of a dialog box.

16.4.1 Your Computer Files

The Your Computer Files control allows you to specify files or folders to be
downloaded to the Compact Flash device. Simply click on the file or folder you want to
download and the Download command button will become enabled and will indicate
whether you are downloading a file or folder.

16.4.2 Compact Flash Files

This control allows you to specify files or folders for upload just by clicking on them.
Simply click on the file or folder you want to upload and the Upload command button
will become enabled and will indicate whether you are uploading a file or folder.

16.4.3 Upload Command

The upload command changes in context depending on whether you have selected a file
or a folder. Pressing this button will cause DGS to request the file(s) from the compact
flash.

It will write them in the same path as that found on the compact flash. If the path is not
present on your computer it will ask if it is OK to create it.

16.4.4 Download Command

The download command changes in context depending on whether you have selected a
file or a folder. Pressing this button will cause DGS to send the selected file(s) to the
compact flash.
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It will write them in the same path as that found on your computer’s disk. If the path is
not present on the compact flash, it will create it.

16.4.5 Delete Command

With version 3.3.5, comes the ability to delete files on the compact flash. There are
certain files that are off limits — such as those required for NeXGen to boot.

DGS will prevent deletion of some files and FTP will prevent deletion of others.

Please exercise caution when deleting files, as the operating system does not keep a
copy in a recycle bin as Windows does.
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17 Errata and Miscellany

DGS is intended to be a helpful tool, and we seek continual improvement. We welcome
your feedback to aid us in this effort.

Errata are dealt with by inline correction and text replacement in this manual.

If you encounter errors in the documentation, or difficulties in the installation or
operation of DGS, please contact the Technical Services Group.
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